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ABSTRACT

This special project aims to study design guideline on high rise building using ETABS
program and SAFE program. This study also contains of two example buildings, five-story
building and forty-story buildings. First, the building has to be classified in to the
appropriate building type in order to use the proper structure elements. Second, designers
have to study how to use ETABS program and SAFE program. SAFE program is used in
order to analyze and design slab (or structures that have behavior as plate), on the other
hand, ETAB program is used to analyze and design the other structures (beam, column,
etc.) After that, designer can define design criteria and parameters, and start modeling
structure in ETABS program and SAFE program. Finally, designer can review the analysis

results and use the results to design steel percentage that required in the cross section.
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4.1.1 YUMDUNIS Define Plan Grids and Story Data

Do you want tao initialize pour new model with definitions and
preferences from an existing .edb file? [Press F1 Key for help.)

Defauledb |

9

VHADHUNITAI1I new shorteut 0 File > New Model

ce

¥ 1 ° " H) = X
"Hu7ﬂ1ﬁﬂ1ﬂuﬂilﬂﬂu61ﬂ73@\1%6‘3!1?]ﬁﬁ‘h’u Llﬂ%%uﬂiﬂiﬁﬁ%’]ﬂi]m&ﬁﬂ\i‘llulﬂ

j1itan4 Grid Dimension (Plan) 2anemuuania luuuasiwvesTuea 3 2 juuy
Uniform Grid Spacing v¢imua lfiszozyianiamiiu

Custom Grid Spacing Ao 11515 muaszez1aldieq

Building Plan Grid S

‘.‘ Grid Dimensions [Fllan] R s e bt et : Stoﬂr' Dimeﬁsions“”

o s g i |3 | +
Uniform Grid Spacing | (‘-“ﬂmals %ry&a@__ e

Mumber Lines in ¥ Direction 4 ‘ ‘ Number of Stories

4 ‘ [ & -5 &5 F ¥ § |
MNumber Lines in 'Y Direction 4 \ Typical Story Height

I Spacing in X Direction 240 I [ | Bottorn Story Height
. Spacing in Y Direction 240 l. |  Costem StoyDiat

¢ Custom Grid Spacing | : Uni.{.s..

i~ &dd Structural UEiects P

[
Vo
P
P
[
[
[
[

= || EE

Steel Deck Staggered Flat Slab Flat Slab with Waffle Slab — Two'Way or Grid Only
Truss Perimeter Beams Ribbed Slab

VURDUL-2 MU UATZYL Spacing in X Direction @i Spacing in Y Direction,
“5” 11 Number of Stores, 179N Grid Only 910 Add Structural Objects and click OK
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YUADUI-3: 1ADA OK, ETABS 22UaA4 “Plan View” 1az “3-D View” luniiiag

4.1.29UNDUMNT Define Material Properties

J 1 il ¥ 1 P
- g N Material Property Data

| i Display Color 'I

Define Materials i i Material Name CONC Color :
g il o e v

Materials i Click to: | ‘ i o e |

‘ & lsoliopic " Ortholiopic ‘ Design Conciete ~ |

Add Hew Malerial.. il ) E i

Analysis Property Data | Design Propeity Data [ACI 318.08/BC 2003) '

Mass per unit Volume 2 246E-07 Specified Conc Comp Stiength, fo [4 i

M :l ‘Weight per unit V olume 8.680E-05 | Bending Reinf. Yield Suess. fy g, T ]

i|! Modulus of Elasticiy 300 | Shea el Yied Stess, s [50 i

| Poisson's Ratio 0.2 ‘ [™ Lightweight Concrete :

" Coeff of Thermal Expansion 5 500E-06 | Shear Strength Redue. Factor !

B shear Moduhie 1500 i

G F a1 R TURCY [ (NIRRT, 115 (1L 1L '

l’ ok | Cancel 1

VUADUN 2-1: Define > Material Properties ke

MINiuAen CONC udaon Modify/Show Material “15{1-1'1911@‘]] material properties
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4.1.3 YUNDUNIT Define Frame Sections

4 7 E)
Define Frame Properties §
|  Properties — [~ Click to: — m 3
\ Type in property to find: i ]Impu:urt %5 Flangs LI .
[4-CompBm ! f
| | RS e : -l |
| ;‘*{gzgi,{_éﬁh?” n Rﬂ: ! I.&dd IMide Flange __]
| |A-GravCol ‘_\ | [Add IAwide Flange -
[ Aol | |&dd Channel 7
|| |&-LatBm % ‘ ‘
| | laLatCol | |AddTee =]
| Fae s % | |addAnge 1
| AT iChdwi2 % | |Add Double Angle
| |ATChdw4 e Wi Add BOx/ Tube ok
A-Trw/ebd : i —
|ATrweb10 i
|aTiwent2 T e e s
[ RO Cancel l
| A

3
o

VUADUN 3-1: Define > Frame Sections .

v

Rectangular Section

a1

i

UANABN “Add Rectangular” vim3minuaguauiavosnidaimn

' 3 _F ¥ & 8 N F-N- N B N N N N _ B N 3

'[*—'T

Section Name |B1
__——mﬂum_——----mm‘--_‘wﬁj
e Ptoperhes e ‘ Froperty Modifiers —  ~ Material
i Section Properties... | Set Modifiers... ] ]':DNE ']
,,,,, o ML |V b vt AN | Loy S S L M 0 DS 1 S L RSB £ LT b I |
- Dimensions ———— ey
[ _§F N &N N B 3 | -r-nn-—a- » >
fDepth (13) 24 | 3
* 9 &
lWidth' (12] [i2 i
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3 - .
| s 8 9
E'D_H;;;"I;— —p——r YT 1 -i R l
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T TN N
0K I Cancel ]

¥ H ]
TUADUN 3-2: 1 “B1” N09 Section Name ua1 lavuianiiida
E

ﬂiﬂﬁulaﬂ N Reinforcement
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Reinforcement Data

2.

&

ﬂuumﬂu‘n 3-3:1mon Des:gn Type |

¥

|~ Design Type——

|

| " Column l f¢ Beam |
| [~ Concrete Caver to Rebar Center |
i 1 e 24 1 :
‘ Bottom i?.d | :

|
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(. Left Right |
Top [o [0 |
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|
|
|
|
1
| I
| |

|

| }
g |
L OK Cancei ] |

1 “Beam” 1dufinn OK

%1ﬂﬁu1ﬁﬂﬁﬂqﬂﬁ N11A14 “DefincFrame Properties”

- Properties

Type in property to find:

[A-CompBm

A-LatCol
[A-TChdw10
[A-TChdw12
[&-TrChdw14
A-Trw'ebB
A-Trw'eb10
A-Trw'eb12
A-TrwebHSS50
A-Trw/ebHS S
A rWebF'IF‘E

3

T (e e e — §
! | Add Auto Select List

i Click to; —

llmport [/#ide Flange

jAdd Rectangular
Add Pipe -

Add Steel Joist 1,

Add SD Section —
Add Nonprismatic il
[ S —

Cancel

VUADUN 3-4: MUUA “Define Frame Properties” Iauaen “B1”

v

@ =] 2 Y
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Circle Section

Section Hame

|c1

- Propetties IR SRRy

Section Properties... i SetModifiers...i
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- RS TR
I Dimensions = l

Cancel ]

| B

S
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1a1a0nN Reinforcement
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|
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|
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el
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s

udIna OK

33

VUADUN 3-6: MHUA Design Type W'l Design Type 1790 “Column”

dl. 1 4 H 5 ra T
YUADUN 3-5 : Tef¥e “C1” 11 section properties 31n1iuldaA w199 Azl

Diamneter [t3] 20 lf 2
| 1?‘%\\
LB B R e . .
| J<le N
! L 3 L
1 | .
- Concrete I -_!___-___—_"_-_E_E_ii s __.“
Reint s
_ | einforcemen I ' Display Color '—-
AR R S S—




4.1.4 TUADUNT Define Slab Sections

Define Wall/Slab/Deck Sections

i
i ! (ST R p— o Click to: —
i N _ i
| | [DECKT - [Add New Deck ~ |
I 7 [ ey T Y
I :j,fﬁ_f; p— I | todife S how Section... I 'i
' i Delete Section | 3
; : [
[ | oK
i ‘ Cancel
L :

VUADUN 4-1 : 2 Define > Wall/Slab/Deck Sections > “SLAB1”

1&291A1 UIE0N Modify/Show Section

Wall/Slab Section

A i T PP Al i NS A et =
I.._ — e ——— T —————— ! !
i Section Name ISLAE'I | |
AN 155 ek I N £ W
| LT — . Ladle S - — i =Rk E i
L Material CONC vl i ‘

- Thickness l ]‘
\
\

Membrane ]E I ‘
Bending !E i ‘

., Type )
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|

- Load Distribution
[™ Use Special One-way Load Distribution

Set Modifiers... Dizplay Color I_
I 0K l Cancel l

¥ a o . )
YUADUN 4-2 : AN UA Thickness = “6” 14 Membrane 118 Bending 1a7na OK
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4.1.5 TUADUNT Define Load Cases

Define Static Load Case Names §
- Loads ————————————— — |

f Self Weight Buta '

} l s shokStlen s v whypmm we wm mbd ltiplier Lateral Load ¥ 1

3 = “ L 8 _ N F F 1

| '|SUF'EHDL |SUPERDEAD ~|[0 7 ] || Modify Load i |
|| S s e - o ' |
i ; LVE LIVE 0 ) lodify Lateral Load.._ | '
I SUPERDL - JSUPERDEAD - O oo i o R b

E ! Delete Load | i
| ‘ |
| e T R
| | Tk ol W

¥ 4 4
YUABURAS-1: MIIAY “SUPERDL” Define > Load Cases E
WU "Load" = "SUPERDL", "Type" = "SUPER DEAD" 1182 "Self Weight Multiplier” = "0""

AIAAN Add New Load 132930 OK

4.2.1 N13719 Draw Beam Objects (Frame Members)
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4.2.2 P13 NALE Draw Column Objects (Frame Members)

A i B A
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Tauna “Snap to Grid Intersections and Points™. uaa lndniaoa grid line D
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4.3.1 YUNDUNIT Assign Slab Sections

2 '
a )

YUADUN 8-1:

L7 Draw > Draw Areas Objects >Draw Areas

i =1 ' .
li/fimyiden Property 171 “SLABI” 91n1111A19 Properties

e Edit Yiew Define Draw Select Assagn Apalyze Disglay Design Qntions Heip

D MW v B geecOuect
S LR R Reshage Object

Wirgr 08 W@ X, N

I-

ay

O« Tz« -,

2 Rh T L

L=] Create Argas at Click (Plan, Flav)

e Draww Walls (Plony

3 Craate Walls in Region or at Clice (Plan)
3 F3 Draw Wimdows

T Draw Doors

Lol | 2D View A
. __.._.I
-y o R R AN —

a3 Deyi Mode

2 ]

n
P Yo - STORVS - Ebevonin 720

Mwhum———————

e

e T p—_—
Hore cipace b

na- - -
| Dewerg Coonal

AT v Zrem

(S Speves = |[GIDRAT 3 Vi

2 — o A : -4
Vunoun 8-2: 110N “Snap to Grid Intersections and Points” !
u;y) Y o ;d'
v limhnugnnaaa
-3 A Plan View - STORYS - Blevation 720 |5 ] | a2 DVew o
L
.\; P, i >
'\ Y ‘1 If ‘
el L
%"-I - !
4/ i
» B i >
: .f"\ " P
& L /!
N :
: :
o i
i
b |
: i
| Double click__ . |
W ’”~ P
Ie \_. \,,‘.
o %4130 YP105 272000 i Srvics I (P

39



YUADUN 8-3: View > Set Building View Options, iAon “Object Fill”

RRITGET “Apply to All Windows” udnA OK.

Set Building View Options

[ Visible in View
[V Story Labels
[T Dimension Lines

. |v Reference Lines

? [V Reference Planes
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Cancel |
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ACI 318-08 Beam Section Design

Beam Element Details (Summary)

AW

]

Level | Element | Section ID | Combo ID | Station Loc | Length (mm) | LLRF Type
STORYS B22 B1 DCON2 230 6096 Sway Special
Section Properties
|
b (mm) | h (mm) | b(mm) | ds(mm) | dg(mm) | dg(mm)
300 600 300 0 60 60
Material Properties
E.(MPa) | f.(MPa) | Lt.Wt Factor (Unitless) | f,(MPa) | f, (MPa)
24821.13 24.00 1 413.69 413.69
Design Code Parameters
¢ T ¢ CTied @ CSpiral V] Vns @ Vs Q) Vjoint
0.9 0.65 0.75 0.75 0.6 0.85
Design Moment and Flexural Reinforcement for Moment, M u3
| Design Design | -Moment | +Moment | Minimum | Required
-Moment | +Moment  Rebar Rebar Rebar Rebar
kN-m kN-m mm? mm? mm? mm?
Top (+2 Axis) -29.1503 0 144 0 192 192
Bottom (-2 Axis) 0 14.5751 0 72 95 95
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Shear Force and Reinforcement for Shear, V 2

Shear V , Shear OV, Shear OV, ShearV, Rebar A./S
kN kN kN kN mm?*/m
34,0612 109.3812 0 12.034 0

Torsion Force and Torsion Reinforcement for Torsion, T u

T, Ter Area A, | Perimeter, p, | Rebar A./s | Rebar A,
KN-m kN-m cm? mm mm?/m mm?*m
0.6949 6.2702 955.6 1473.2 0 0
Design Code Parameters
(D T ‘D CTied m CSpiral m Vns q’ Vs m Vjaint
0.9 0.65 0.75 0.75 0.6 0.85
Shear/Torsion Design for Vy2 and Ty
Rbar Rbar Rbar | Design | Design | Design | Design
A A /IS A Vi Ty M P,
mm?m | mm*m | mm? kN kN-m | kN-m kN
0 0 0 34,0612 | 0.6949 |-29.1503 0
Design Forces
Design | Design
Vu2 M ul
kN kN-m
34,0612 | -29.1503
Design Basis
Design | Conc.Area | Area | Tensn.Reinf | Strength | Strength | LtWt.Reduc
Vi A, A,y A-st fis fes Factor
kN cm? cm? mm? MPa MPa Unitless
34,0612 1672.3 1858.1 192 413.69 27.58 1
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Shear Rebar Design

Stress | Conc.Capacit | Uppr.Limi | Conc.Capacity | Uppr.Limi | RebarArea Shea Shea Shea
v y Ve t Vmax Dv, | t PV max A,ls rdv. rov, rov,
MPa MPa MPa MPa : MPa mm?*m kN kN kN
0.2 0.87 4.36 0.65 ; 3.27 0 109.3812 0 109.3812

Torsion Capacity

Torsion| Critical | Conc.Area | Conc.Area | Conc.Area ! Perimeter | Perimeter
Tu q)Tcr Acp th An I Pcp Ph
kN-m kN-m cm? cm? cm? mm mm
0.6949 6.2702 1858.1 1124.2 955.6 1828.8 1473.2
Design Code Parameters
o] T w CTied ® CSpiral @ Vs m Vs P Vjoint
0.9 0.65 0.75 0.75 0.6 0.85
Flexural Reinforcement for Moment, M u3
Required | +Moment | -Moment | Minimum
Rebar Rebar Rebar Rebar
mm? mm? mm? mm?
Top (+2 Axis) 192 0 144 192
Bottom (-2 Axis) 95 72 0 95
Design Moments, M u3
Design Design
+Moment kN-m -Moment kN-m
14.5751 -29.1503
Flexural Reinforcement for Major Axis Moment, M,
End-I End-l |  Middle Middle End-J End-J
Rebar Area Rebar Rebar Area Rebar Rebar Area Rebar
mm? % mm? % mm? %o
Top (+2 Axis) 96 | 005 | 48 0.03 192 04
Bot (-2 Axis) 72 | 004 | 145 0.08 95 0.05
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Flexural Design Moment, M,

End-I ‘ End-I Middle Middle End-J End-J
| Design My Station Loc Design My Station Loc ‘ Design Mu Station Loc
! kN-m | mm kN-m mm | kN-m mm
Top (+2Axis) | 146405 | 254 S i 201503 | i
Combo | DCON3 DCON2 DCON2 |
Bot (-2 Axis) 10.9967 | 1371.6 22.1566 3048 14,5751 | 5842
Combo DCON2 ‘ DCON2 DCON2 |
Shear Reinforcement for Major Shear, V ,
Endl  Middle End-J
Rebar Ay /s Rebar Ay /s Rebar Ay Is
mm2m 1 mm2/m mm?/m
0 T 0 0
Design Shear Force for Major Shear, V ,
End-l End-| Middle Middle End-J End-J
Design Vu Station Loc Design Vu Station Loc Design Vu Station Loc
kN mm . kN mm kN mm
39.3384 254 | 0.6731 4165.6 44.4043 5842
DCON3 | DCON3 DCON3
Torsion Reinforcement
Shear Longitudinal
Rebar A, /s Rebar A
mm?*/m mm?
0 0
Design Torsion Force
Design Tu Station Loc = Design Tu Station Loc
kN-m mm kN-m mm
~ 0.6949 5842 0.6949 5842
DCON2 . DCON2
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ACI 318-08 Column Section Design

Column Element Details (Summary)

Level | Element | Section ID | Combo ID | Station Loc | Length (em) | LLRF Type
STORY1 Cl DCON2 0 365.76 Sway Special
Section Properties

d (cm) h, (em) dc (cm) Cover (Torsion) (cm)
50.8 47.752 3.048 -0.936
Material Properties
E, (kN/em?) ', (kN/em?) Lt.Wt Factor (Unitless) f, (kN/em?) f,, (kN/em?)
2482.113 2.758 1 41.369 41.369
Design Code Parameters
q)T q)CTied q)CSpiral (DVns q)Vs (DVjuinI
0.9 0.65 0.75 0.75 0.6 0.85
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Axial Force and Biaxial Moment Design For P, , M, , M,
Design P, Design M, | Design M, | Minimum M, = Minimum M, | Rebar % | Capacity Ratio
kN kN-cm kN-em kN-em kN-cm % Unitless
449.2622 0 1369.351 1369.351 1369.351 16.53 0.13
Axial Force and Biaxial Moment Factors
C,, Factor 8"5 Factor 85 Factor K Factor | Length
Unitless Unitless Unitless Unitless cm
Major Bend(M3) 0.6 1 1 1 304.8
Minor Bend(M2) 0.6 1 1 1 304.8
Shear Design for V,, V,
|
Shear V, Shear q)Vc Shear (I)Vs Shear (DVD | Rebar A /s
kN kN kN kN cm?*/em
Major, V, 2.4722 153.8841 0 0 0
Minor, V , 2.4038 153.8841 0 13.6289 0
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COMPONENTS | URA(FLOOR) | MAIBANDUNTH REBAR GRADE NN
L25-184A1 fc' = 280 ksc fy = 4,000 KSC
= ADUATA
®
1= fy = 4,000 KSC =
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= MAIwAN 28 U
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=
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115981 Wind Load Cases (UBC97)

Second (S1)

Parameter Load Case
WINDX WINDY
MNAN1aLTIaY X Y
ﬂ'J13JL§’JE13J 90 mph
szimvosau E (Auoou)
dlszapudingy 13
- UFILHUAY 117 (Equivalent Static Force Parameters) IBC 2000
Parameter Values Remark
. : (Ct =0.020)
Time Period (T) 1.47
Response Modification Dual System:
Factor (R) 5.5 Ordinary RC Shear Wall
Seismic Group I
_ (AUDDY Soft Clay)
Site Class E
Response Acceleration at 0.45
Short Period (Sg) i
Response Acceleration at | 0.18

79




s T a d.1 o o [ =)
A7 ﬂthNﬁ'J[ﬂi'lS‘ﬁﬂﬂNlN HFﬂ‘Hﬂ'IHW\i IUUFIRNDH

k—- __| BiElevation View - 4  Resultant MMAX Diagram (01DL) [N-m/m] - X
R || B
Lo [ | —
- |
{L=

\

\

1
L |

_ smidadifian) Mmax

alil:j !

Max = 170131.96 Nm/m at [0.725m, 20575 m]; Min =-527753.12 Nem/m at [0.725m, 19.675m]

511 5.9 naaam Tuwudveaiumas uus udau

" o o [ =) &
M TuuduInga TuMUWIT UL URDY A9 M max= 170,131 N-m

=) g { o 1 1 Al 2‘; o g} dl.
NAYURA UM UITDIADITZHINYY 12 AV TU 13 NANUEY 20.575 1IAT

80



o ' g4 w =4 ° o
ﬂ'JfJUNHﬁﬂqwuﬂﬁﬁ’}ﬂﬂlﬂaﬂ%uﬂ1iﬂﬂﬂll']J'U ﬂ'lllW\ﬁ‘]JUinﬁﬂu

m Elevation View - 4 Pier Long.itudingll Rej_:gfgrcing Areas (cm?) (ACI318-08) ] v X

. PSR
P I —

ol 17T |
mal bt ; I FATOTT 484

R

TR

|

| RTINS
i LA MR AT

{

|

|

|

\

STty
sakporaed
4ty
X . | CRERY
plomss 1
qugi BN ehena
Rasi— gl
i BWieN ke
Cp T
1 M. il
{_ IREE
gy ImaE Forani g
B DA
1 L] SRR )
S AL
L
AT T

260 325 390 455 520 585 650

D

]
=

P < ° ) 2
JU7 5.10 ugaanumanTumuwaTuus U oy

81



[4:]

4,05)

L02(P2A
42.70)

(P38+ Pl

16.75)
LO5(P38+
16.75)
L04(P3A
#5.40)
IL04(P3A
14540)
L03(P2B+
4.09)

P05
P05
PO5

P05

L03(P2B+
4,05)
L02(p2A
+2.70)
L02(P24
+2.70)
LO1(P140

P05

P05

P05

5]

.00}

L01{P1+40
a0
L05(P38+

P05

PG

6.75)

L05(P38+
6.75)
L04(P3A

PO6

P06

+5.40)

L04(P3A
+5.40)
L03(P2B+

PO6

Po6

L03(P26+

4.05) s

PO6

= =1 A A o @
MTINN 5.2 Uﬁﬂ\‘]lr%ll'lmlﬂﬁﬂlﬁﬁuﬂulﬁfl]']ﬂﬂ_ﬁBﬂﬂ!lﬂUﬂ“lWQiUlﬁﬂﬁﬂu

Botfom
Top
Bottom
Top
Bottom
Top
Bottom
Top
Bottom
Top
Bottom
Top
Battom
Top
Bottom

Top

Uniform
Uniform
Uniform
Uniform
Uniform
Unéorm
Uniform
Uniform
Uniform
Uniform
Unform
Uniorm
Unfform
Uniform
Uniform
Unform

Unform

DB20
DB20
DB20
0B20
DB20
DB20
D820
DB20
DB20
0B20
DB20
DB20
0B20
0B20

D820

DB20

DB20

DB20

0820

DB20

DB20

DB20

De20

D820

0820

DB20

DB20

DB20

DB20

D820

250

230

230

230

230

250

250

250

250

250

230

230

250

250

250

0.25

0.25

0.25

0.25

0.25

0.25

0.25

0.2

0.25

0.25

0.25

0.25

0.25

0.25

0.25

Bottom
" leat

0.92 Topleg1

0,92

Bottom
0.9z
legl

0.92 Toplegl

Botfom
0.2
legl

0.92 Top Leg 1

) Bottom
leql

0,92 Top Leg 1

09

Bottom
0.92
legl

0,92 Topleg1

0.92 Bottom

" legl
092 Toplegl

Bottom
0.92
Leql

(.92 Top Leg 1

Bottom
i legl

0,92 Topleg 1

23099.9

23099.9

23093.9

23099.9

23099.9

23099.9

23099.%

23090.9

23098.9

23099.9

23100.1

23100.1

23100.1

23100.1

23100.1

23100.1

23100.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

20797

277997

27799.7

27799.7

21799.7

20799.7

27199.7

23099.9

23099.8

23099.9

23099.9

23099.9

23094.9

23009.9

23009.0

23095.9

23099.9

23100.1

23100.1

23100.1

23100.1

23100.1

23100.1

23100.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

30800.1

27799.7

277199.7

27799.7

27799.7

2779.1

27799.7

27799.7

3000

3000

3000

3000

3000

3000

3000

RGLY

gMiﬂlLl‘ﬁ&]’LbLSLMbL

WLy

L

i

m

H@giDEHFLSPMHLUﬂI'LT’iUG@ELUUL{LM



€8

:; (] I~ o Y
A15199 5.3 LEAIN1s laan U was L uiau

FO1-FO2

FO2 - FO4

FO04 - FO7

FO7 - FO8

Sze 3150 x 500
ME = 15-DBE20
S DB12@1S0 (1M

TB: DB12@300 (7T)

Size 3150 x 590
MB = 18-DR20
So . DB12E200 (1H)

TB : DB12E300 (7T)

Sz 3150 x 500
MB = 18-DR20
So . DB12@200 [ 1H)

TB:DB12@300 (7T}

Sze 3150% 500
ME = 18-DB20
Sa . DB12E@200 {1H}

TB : DB12E&300 (7T}

pecy

gBTUgMT}JLELUbWJTTL‘LI

L

o

]

T‘L@.E_}?L\S?TFLSDWTLUH



%5 SIRE 7 & qw )
WAz Ha0819mseuaIveeiy 13a1u dae11sunsu SAFE

::! Deformed Shape - b.isplacements (DEAD) [mm]

.:: 1 o .é’ 4
51 5.11 namensusudvoaiiul3am

84



a d o T a di T d d‘l' ¥ Y
Nfl’)!ﬂi13ﬁﬂ’3i)£lNNﬁ’)lﬂﬁ]B‘HﬂﬂN!‘Nuﬂ‘ll’t’]\iWHvlﬁﬂ'l‘l—! ﬂ’JUT‘LIi!.m‘iN SAFE

i3 Slab Resultant Mmax Diagram - (DEAD) [kN-m/m] @

dl o 1 =1 1 g
519 5.12 uaasdregana Tz lumudveanu 13a1u d2eTusunsy SAFE

W

[l
=

A Tuudnnganusnaudunia 4-C TA1AD M mar= 303.7345 kN-m

85



o

a o T [~ g
HaINTIZHA0e1a S aumaniu 15a1u daeTasunsu SAFE

12 Slab Finite Element Design - Bottom Rebar Intensity (Enveloping) [cm2/cm] - Direction 1

{ a o T o &
3UM 5.13 usraamadnszvdrogranSunamaniiu 15a1u AeTisunsu SAFE

86



d 4 gy
Twmaniu 151y

! =
avian

1

AIDYNLUAAINIT

w

_
() .
|
|
i 00271
_ I —
_ _ _ ! ERE
(msa4) !
_ (mte +) _ _ 143 |
o345
_ | i
- |
|
1
!
lllllllll 1 PG R AR s o | § e ma AN Tl R - m vt
-
| ki !
R i !
L.-._l_.-._lj _
L ) , ;
L 1 b ;
4 (v]

_ e L — L
4 i il ST A
i e i 3 CHEN

| ] Q i

L i m _
! T 2
i i “JE “
! o |E %
o ! / 1 |
_ A [ r
|
I
|
] _ |
wl T _
(R AT i

d & nw
Tumaniiu13au

=
aan
87

3

71 5.14 naaans |

U




UNN 6
F2
agUwanisnaaewaz Yorauenuy

6.1 agwa

a {2 | a o
TnssnuieiiiluTasanui lddnugduuuTaseadeenssiaanquazdesimualu

MIPAALVUDINT TAuMiaD95InTEIAe NNARDNISODALLL

o = = o
1NNsaduUUsansInseadwomsnounsaas uandle TUsunsy ETABS eu1sn
° ~ o ° ‘:J o 1 1 Y] ] as g T 1 (]
AMUINAATIZH HITINTLIV0IMTN AmsuudLaza Tumudaauaaruaua1es lin
= o as s =Y =
ety aru e AuweSuusudou Taeldsunsy ETABS 1 unsizvmidSuiunisiasy
= o o A [ Y o =
manlue auags s uusanou auTUsunsy SAFE agldmuiamilSviansiasy

o &4
wanluny
v
6.2 VolaHdIUE

= o i) =< F ) o Yed 1 ) = L4
ﬂ']'i'Jlﬂi']%'ﬂTﬂ'iﬂff'iTQﬂ'JﬁﬁﬂH']sU@ﬂTWHﬂ[lazﬂ15ﬂ1u3m@ﬂﬂlLUU1HﬂﬂBuu1M1?Lﬂi’l3'ﬁ

A

TaeldTdsunsy TaedaTdsunsuervazimalinudanaiald suiiieauiainms lausa
o o 1 P 9 A (= Y o o
nsziin linseruFuaiuveaTaseada wioorwoz ludlu llmudesmualunisesnuuy v
Ly 2 [ o 3 9 1 = = = ° Y a a own Qy 1
T lasaasiasuusanseimlddosnitanuiluase 39 lvinanmsivalusuaiuvos

Tnssadha

88



UIIUIUNTU

o a d a = Y.t
UsrTumd waresnn, 2555, Tl ludeamua Tuanudanssy, Auiasan 5. ngunna :
PNAINTANMINAY,
o =
Twyad Taygnnz T, 2545, mseenuuueima. njamwa : lausiaue

=) A d < o2 =
AT WNBETYNDY, 2548 MIANTIZHINSI@IINAMANS, NFUNN : FUITOIATUATUNN

o
=)

WITITENA (51U HE, UIUNS A 1AT0195, UeanqEa gaNaIsTMNE, 2551,

a a

manfFeuisuyanmalnssa¥iavedeinsgs 23 ¥ uaz 36 ¥ Tunsaioonuy

'
A o =

Mo FuIsIaN aznstioanuuIe S UITINTENUMDIHUAY 1. YSmgyan
=Y & - @ oA a = Y o as
wusilSuganiuda aoniuma TuTagws zeouna i InuNMITaIANTEl
- = d d -
1A% WNTII3 YN0, 2548. MyuAzHIasea anamans. njaunnd : lausiauy

Rajasekarah, S., 2008. Finite element analysis : in engineering. n.p.

Hoi¥s Foief3, 2554, maiansnoa3 190 IMS gAY, UNANIIYM S

39



